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Using PalmPrint to Transmit Data to A Computer

NOTE: This manual supports three different products. PalmPrint is 
our general purpose printing software, which prints a wide variety of 
information itself, and also provides printing services to other 
applications. SCS Print Server is a stripped down version of the 
software which only provides printing services to all other applications 
which choose to support it, and does not itself do any printing. And 
finally, there are special versions of SCS Print Server which support 
printing only to a single application. Most of the material in this manual 
applies to all three versions, with a few exceptions. The name of the 
application file, which you need to know when you install the software, 
is PPrint.prc is you have the full version of PalmPrint, and 
SCSPrint.prc if you have the server version. And when you go to the 
application window on your Palm to start the application, the 
PalmPrint icon is labelled "PalmPrint", while the SCS Print Server 
icon is labelled "SCS Print".

Chapter 1: Installing the Software

Installing PalmPrint in Your Palm

Whether you downloaded the software from our Web site or received it in the mail, you should have 
a file called PPrint.prc (or SCSPrint.prc, as appropriate) on your computer or floppy disk or CD, 
along with a series of companion programs - PalmPrint_Address.prc, 
PalmPrint_Datebook.prc, PalmPrint_Mail.prc, PalmPrint_Expense.prc, 
PalmPrint_Doc.prc, PalmPrint_Eudora.prc, and PalmPrint_iMessenger.prc. Please note 
that some or all of these programs may be optional, depending on how you licensed your software, 
that is, you may need to purchase a separate license to use one or more of these companion 
programs. If you do not have the file PPrint.prc, you cannot proceed. If you do, 
here's how to install it on your Palm handheld device:

From a Macintosh:

Select the HotSync menu from the "Instant Palm" menu on the upper right of your menu bar; in the 
sub-menu, select Install Handheld Files. Click on the Add To List button. Locate and select 
the file PPrint.prc, and click Add File. Click on Add To List again and select 
PalmPrint_Address.prc, and a third time and select PalmPrint_Datebook.prc. If you want to 
print mail from the Palm Mail application, you should also install PalmPrint_Mail.prc. If you 
want to print mail from the Palm VII iMessenger application, you should also install 
PalmPrint_iMessenger.prc. If you want to print mail from the Eudora application, you should 
also install PalmPrint_Eudora.prc. If you want to print expense reports from the Palm Expense 
application, you should also install PalmPrint_Expense.prc. If you want to view and print "Doc" 
files from your Palm, you should also install PalmPrint_Doc.prc. The next time you HotSync your 
Palm, the programs will be downloaded.

From Windows:

Using the Install software that came with PalmPrint: As part of the download or on this diskette or 



CD you should see a program named Install (Install.exe) in the same folder as the 
PalmPrint software (PPrint). Double-click on Install, and it will copy all of the files to a new 
PalmPrint folder in your Palm folder on your computer, and at the same time will perform all the 
steps to install the software in your Palm, except for the final step of performing an actual HotSync. 
When you do your next HotSync, the software will be installed in your Palm.

If the procedure above does not work for some reason, or if your desktop computer is supporting 
multiple Palms, try the "manual" procedures described in the next few paragraphs; if those don't 
seem to apply to your setup, please consult the manual that came with your handheld device (Palm, 
Handspring Visor, Symbol SPT1500, etc.), which contains instructions on installing applications 
into the handheld

Using current Palm desktop software: Try this first: Double-click on the file PPrint.prc. If your 
system is correctly configured with the latest Palm software, a window labelled "Palm Install Tool 
3.0" (or perhaps higher) will appear. Check that the user name displayed is the name of the unit on 
which you are installing the software, change it if it isn't, and click on OK. A new window labelled 
"Palm Install Tool" will appear with a list of software to be installed in your Palm, which should 
include PPrint.prc. Click on Add, select PalmPrint_Address.prc, and then again to select 
PalmPrint_Datebook.prc, and, if you want to print emails from the Palm Mail application, 
PalmPrint_Mail.prc as well. If you want to print mail from the Palm VII iMessenger application, 
you should also install PalmPrint_iMessenger.prc. If you want to print mail from the Eudora 
application, you should also install PalmPrint_Eudora.prc. If you want to print expense reports 
from the Palm Expense application, you should also install PalmPrint_Expense.prc.If you want to 
view and print "Doc" files from your Palm, you should also install PalmPrint_Doc.prc. Click on 
Done to show you are done, then on OK to confirm. The next time you HotSync your Palm, the 
programs will be downloaded.

If the method in the previous paragraph didn't work, try this: Start your Palm desktop software. 
Click on the Install button. Check to make sure the User name displayed at the top of the Palm 
Install Tool window which appears is the user name of the Palm handheld device on which you want 
to install the software; if not, select the correct user name. Now click on Add. Using the file browser 
which appears, locate and select the PPrint.prc file, and click Open. Click on Add, select 
PalmPrint_Address.prc, and then again to select PalmPrint_Datebook.prc.Now click on the 
Done button, and then on OK. The next time you HotSync your Palm, the program will be 
downloaded.

Installing Fonts

On most printers, PalmPrint uses the "built-in" fonts of the printer, so you should NOT install any 
fonts in your Palm. If you do, they will simply take up memory and not be used. If you will be using 
a Pentax PocketJet 200 or SiPix Pocket Printer A6, however, the printer does not have built-in fonts. 
Also, if you will be using an HP-compatible printer but require accented characters (e.g., European 
language characters or currency symbols), you may want to install fonts (see the discussion below 
under selecting Printer Type for more information about this). In this case you have two options. If 
you don't install any fonts, PalmPrint will use the Palm "screen fonts" for printing. All the fonts 
(Courier, Times, and Helvetica) will look the same in this case (although Courier will still be 
monospaced and the other two will be proportionally spaced), and their appearance will be less than 
optimal. Alternatively, you can select fonts to be installed. There are four sets of fonts, which vary in 
the amount of memory they require on your Palm, and in quality. "Lo Res Plain" fonts take up 36K 
(approximately), and provide low-resolution fonts in plain only. Bold IS supported; the bold quality 
is created "on the fly" using the plain font. "Lo Res" fonts take up 70K and add a "real" bold font 
and thus provide higher quality bold. "High Res Plain" fonts take up 101K and provide higher 
resolution output; "High Res" fonts take up 205K and add high quality bold as well. In general, we 
think that the "High Res Plain" fonts will be satisfactory for most people unless you are using a lot of 
bold in your output, but if space is a constraint on your Palm, the "Lo Res" or "Lo Res Plain" fonts 



should be just fine.

If you are using Windows and run our Install program, you will be given a choice of fonts, and 
you simply need to select the right option to have the fonts automatically installed. With Macintosh, 
we don't provide an installer, but you can simply use the standard Install Handheld Files menu 
to select the fonts you wish to install. The fonts, which are "PDB" files (Palm DataBases), are found 
inside the Fonts folder, in sub-folders by names which describe their function. It isn't required to 
install all three fonts (Courier, Times, and Helvetica) if you don't wish to, but if you don't, and then 
select a font which isn't installed, the results will be as if no fonts are installed (that is, Palm screen 
fonts will be used).

Starting the Application

From the Applications window on your Palm, look for the icon labelled PalmPrint (or SCS 
Print) which looks like this:

Entering Your Serial Number

If you have registered the software, and have obtained a serial number from Stevens Creek 
Software, you enter the serial number by tapping on the word *Unlicensed* in the upper right of 
the main screen. When you do, you'll see this screen appear:

Use Graffiti (or the on-screen keyboard) to enter your serial number (supplied to you by Stevens 
Creek Software); when you're done, tap on the OK button. If you enter an incorrect number, the 
software will let you know. If necessary, tap on the Cancel button to dismiss the Enter Serial 
Number screen. When you have entered the Serial Number correctly, you'll see the word 
*Unlicensed* disappear from the main screen.

If you run into a problem, this probably means that when you provided your Palm user name to 
Stevens Creek Software, you did so incorrectly. Check the name in the Enter Serial Number screen 
shown above, and write it down exactly (including case, i.e., whether the letters are upper-case 
letters like THIS or lower-case letters like this) and email it to Stevens Creek Software technical 
support and wait for a new serial number to be provided to you.

Chapter 2: Configuring the Software

On the top of the main screen when you open PalmPrint, you will see this display:



Setting the Printer Type and Baud Rate is the most important part of configuring PalmPrint. We 
choose to put it in the main screen for two reasons - first, to remind you of how you have the 
software configured, and second, to allow you to quickly change configurations if you use 
PalmPrint with more than one printer.

Printer Type

The Printer Type pop-up menu offers you these choices:

The first choice, Plain Text/None, is provided for the case when you want to use PalmPrint to 
send data to another computer, although you also may find this mode suitable for a number of small 
receipt printers which don't accept standard printer languages. In this mode PalmPrint sends out 
only the text it is asked to send, exactly as it exists. Automatic word-wrapping and page breaks are 
disabled, and no additional control characters are sent. The next choice, Text w/Breaks, is similar, 
but in this mode PalmPrint will add margins and line breaks after the number of specified 
characters (as discussed below).If you are not able to directly connect your Palm to a printer, either 
via cable or Infrared, you can use the Text w/Breaks setting to print via your desktop computer (with 
the Palm in its cradle); this is described in the Using PalmPrint to Transmit Data to A Computer 
section of this manual.

The remaining choices describe various types of printers and printer languages that are in common 
use. If you are unsure of what language your printer uses, you should consult the manual that came 
with your printer. Note that there is not a direct correlation between manufacturer and printer type. 
For example, many printers (such as many Apple LaserWriters) support PCL. Printers from many 
manufacturers support PostScript, but often PostScript is an optional capability on the printer so 
you'll need to be sure that it's installed on your particular printer. If you're completely unsure, you 
can try all the possibilities, but try Epson first, since Epson compatibility is probably the most 
common configuration for different printers.

The most confusing choice is probably HP (PCL) vs. HP (Palm fonts). The first of these is the 
"standard" setting that should be used by most users of HP or HP-compatible printers, and relies on 
built-in fonts within the printer. The second choice requires that you install fonts in the Palm (see 
above), and uses those fonts instead of the built-in fonts of the printer. This method requires more 
memory on the Palm (for the printer fonts), produces slower printing (because more data has to be 
sent to the printer), and also produces lower resolution printing, so in general it is not the method of 
choice. The only reason to do this is if you want to print certain accented characters or other "special" 



characters (including various currency symbols like the pound sign, the euro symbol, etc.), which 
are not supported in the basic mode. This method also produces more accurate word-wrapping for 
Times and Helvetica fonts (see below), but this is unlikely to be an important enough consideration 
to warrant the disadvantages.You are able to use either setting, so you may wish to use the faster HP 
(PCL) setting for some print tasks and the slower HP (Palm fonts) setting for others (assuming 
you have installed fonts in the Palm).

Baud Rate

The Baud Rate pop-up menu offers you these choices:

In some cases, you will be able to choose a variety of baud rates; in other cases the baud rate is fixed 
by your printer. You will need to determine the appropriate baud rate. The last section of this manual 
contains settings for some printers of interest, although you may also need to consult your printer 
manual for this information. If you connect your Palm to another computer (instead of a printer) and 
use the "Plain Text" mode of PalmPrint to transmit information to a terminal emulation program 
(see next chapter), you'll probably be able to vary the baud rate within the terminal emulation 
program (and within PalmPrint).

You'll also see three "Infrared" choices on the pop-up menu. Select one of these to use the infrared 
(IrDA) port for printing to IrDA-capable printers. For most IrDA printers, you should select 
"Infrared," the first choice on the list. If you encounter difficulties communicating with the 
printer, then you can try the other two choices, "Infrared (Fast)" and "Infrared (Slow)" to see if you 
can reliably establish communication with either of those settings (the Seiko DPU-3445 requires a 
setting of "Infrared (Fast)", as does the Pentax PocketJet 200). If your handheld computer does 
not support IrDA (for example, it's an older, non-upgraded Pilot or PalmPilot), then the software 
won't let you select Infrared.

If you are using a serial-to-parallel converter cable, data arrive at your printer in a "parallel" mode, 
but they are sent out of the Palm as a serial transmission, and the baud rate must be set above to 
match the baud rate required by the serial-to-parallel converter. Stevens Creek Software sells two 
different cables for this task. The GA945CE9M has a 9-pin connector on one end which mates with 
either a "HotSync cable" (sold by Palm) or the cable coming from the HotSync cradle. If you are 
using this cable, set the baud rate to 9600. The GA945PP has a "Palm serial" connector on one end 
which mates directly with all Palm handheld units except the Palm V. If you are using this cable, set 
the baud rate to 57600.

If you are "printing" to terminal emulation software on your host computer (see Chapter 4), set the 
baud rate to match the baud rate in your terminal emulation software. If you are printing via cable to 
the serial port of a printer, the baud rate set in PalmPrint should match that of your printer. Some 
printers are fixed (typically at 9600 or 19200 baud - the Monarch 6015 requires 19200 baud, for 
example), while others have baud rates which can be selected. Consult your printer documentation 



for information on what the fixed baud rate of your printer is, or how to change it if it is adjustable. 
If you set the baud rate incorrectly, you will often see output on your printer, but it will consist of 
nonsense characters. If you see output like that, the likely solution is to change the baud rate. 
However some printers will not print anything until they receive the final "page eject" command, and 
if that is garbled like the rest of the page, you will see no output whatsoever. In other words, an 
incorrect baud rate is not a guarantee that you will see garbled output; you may see no output at all.

Manual Feed

If you check the Manual Feed box PalmPrint will select the manual feed tray for paper input. In all 
other cases the built-in paper tray will be used. This setting is only applicable to certain printers; on 
other printers it is ignored.On some printers with manual paper insertion, such as the Pentax 
PocketJet 200, checking this box displays a box reading "Insert paper, then tap OK" to allow time to 
insert pages.

More Configuration Settings

Clicking the More button will display this screen, which allows you to choose additional settings:

Char(acter)s per line and Lines per page set the maximum values for those parameters, which 
are used by the software when it does automatic word-wrapping and page breaks. The values are set 
by default to numbers appropriate for 8 1/2 x 11" paper; change them if you wish. Set lines/page to 0 
if you are printing on continuous roll-feed paper and don't want page breaks. Characters per line has 
a maximum of 255; lines per page has a maximum of 99. However most likely neither of these 
values is correct for your printer; you are responsible for setting these numbers to values which are 
meaningful for the printer you are using.

On two printers, the chars/line is used to set the font size. On the Seiko DPU-3445, if you set the 
Chars/line to 52 (or fewer), printing will be in the standard size font for that printer; if you set the 
Chars/line to 69 (or anything larger than 52), printing will be in a small size font. On the Monarch 
6015, you can set Chars/line to 48, 42, 38, 32, or 24 (42 is "normal") to get progressively larger 
characters.

Note that characters per line will vary with the font size chosen (see below); if you print in smaller 
fonts, more characters will fit on a line. If you set the characters per line too low, and you print a 
memo which contains paragraphs longer than one line, the printing will not fill the page, like this:



This is an example of setting the
characters per line too small for the
page so that the full page is not
filled up as it should be.

If your printed page looks like this, you can safely increase the number of characters per line. On the 
other hand, if you enter a number of characters per line which is greater than the number which really 
fit on one line, than the lines will wrap around, like this:

This is an example of setting the characters per line 
too large for the
page so that each line wraps around because the 
software thinks
the paper is wider than it really is.

If your printed page looks like this, decrease the number of characters per line.

Left margin and Top margin should be self-explanatory; note that the former is measured in 
characters and the latter in lines. Note that on printers with continuous roll-feed paper, the top margin 
setting is also used at the end of the printing as a bottom margin to ensure that the paper moves past 
the cutting mechanism.

Font can be set to Courier, Times, or Helvetica. Automatic word-wrapping is only accurate if you 
select Courier font. The software counts characters only, not actual character widths, and thus the 
word-wrapping for proportional fonts (Times and Helvetica) will be approximate only. If you are 
printing material which has columns which are supposed to line up (such as a table), you must select 
the monospaced font Courier in order to get proper output. Font size can be set to 12 pt, 10 pt, and 
9 pt. Bold sets the default print to be bold rather than plain.

Orientation can be set to P (Portrait - long axis of the page vertical) or L (Landscape - long axis of 
the page horizontal). When you change orientation, the Characters per line and Lines per page will 
change, because there are actually two sets of those numbers, one for each orientation. Changes you 
make to the Characters per line or Lines per page always apply to the currently selected orientation. 
Orientation is applicable only to PCL and PostScript printers and is ignored on other 
printers.

Line termination can be CR (Carriage Return), LF (Line Feed), or CRLF (Carriage Return-Line 
Feed). This comes into play mostly when you are using PalmPrint to transfer information to 
another computer, in which case the end of line character(s) may affect how the data appears on the 
receiving computer or software. Leave this setting at CRLF if you aren't sure, or 
experiment and see what happens. When you are printing, most printers have some kind of setting 
(often set by DIP switches) which set the end of line character. Again, if you aren't sure, leave the 
setting at CRLF, but consult your printer manual for more guidance on the appropriate setting.

Auto-detect IR Printers is used to take advantage of a feature of IrDA communication, in which 
IrDA devices identify themselves by name such as "BJC-80" or "DeskJet 340". If you regularly print 
to more than one type of IrDA device, you probably want to leave this box checked. In that case, if 
you try to print to a printer which does not match the currently selected printer type (set on the main 
page), the software will automatically switch the printer type for you. This identification process 
does take a fraction of a second, though, and if you only print to one type of printer, you're probably 



better off just setting the printer type on the main screen and leaving this box unchecked. Note that if 
you have an HP printer, checking this box will result in setting the printer type to "HP (PCL)", so if 
you intended the printer type to be "HP (Palm fonts)", you should leave this box unchecked.

Use CTS Transmit Flow Control should be checked when you are sending data via serial 
transmission to printers which may not have a sufficient internal buffer to accept everything being 
sent; this is particularly true with small receipt printers. This mode may also useful when you are 
using PalmPrint to send data to another computer and want to ensure the most reliable data 
transmission. If you are sending data via cable and some characters are being lost, it is almost certain 
that use of this mode will solve the problem. However you should NOT check this setting 
unless you need to, because if you do so and try to print via the serial port without being properly 
connected, the software may hang (tap Cancel if it does).

Infrared Setup and Testing

If you will be printing via infrared, you'll first want to test the IR "connection" to make sure that 
your Palm III can "talk" to your printer. After setting the Baud Rate to Infrared (see above), point 
the top of your Palm III (you can hold it level, you need not turn it so the IR port which is on the 
back side is visible) at the IR port of your printer (check your printer manual if you aren't sure where 
the IR port is). The distance is critical. You cannot be too far (our experience shows a 
maximum distance of 20 inches (50 cm), but this will vary with your handheld unit as well as your 
printer. If your batteries are weak, longer distances will be less likely to work. You also must not 
be too close. Again, distances vary, but it seems that as you get closer than 4 inches (10 cm), 
transmission can become unreliable with some printers. Now, once you have the units aligned, tap 
on the Menu icon and select Test IR Communications from the menu:

A window labelled PalmPrint Status Window will appear on your screen, and show you a message 
"Looking for IR printer..." After a few seconds, it should identify the printer, and you'll see (for five 
seconds, before it erases itself) a message like this: "Printer ID: BJC-80". If instead you get a 
message "No IR devices found within range!", you'll know that something is wrong. Check the 
obvious (did you remember to turn the printer on?) and then experiment with distance and angle. If 
you have access to another Palm III with IR, you can try pointing your Palm III at the other one 
(make sure the other one is on at the time). In this case you should see a message that says "The IR 
device found is not a printer!", which will at least let you know that your IR port is functional.

Aside from distance, the only "trick" with IR is timeout issues. If you have a failed communication, 
you may still have partially engaged the IR software in the printer. If this happens, further attempts to 
communicate will fail, because the printer acts as if it's not there. You either need to turn the printer 
off and on again, or, usually, just wait for a timeout period (15-30 seconds) for the printer IR 
software to "reset" itself. In other words, don't just keep tapping on Test IR Communications 
repeatedly, but "give it a rest" for a short time if the effort doesn't succeed.

Batteries may also be an issue. At a battery level significantly above that at which you receive a "low 
battery" warning from the Palm operating system, IR printing may fail, so for your first attempt at IR 
printing, make sure you have fresh batteries.

Once you understand the distance constraints and are successful in establishing reliable 
communications, you'll find that you can successfully communicate with the printer every time, so 
don't be discouraged by any initial failures.



Chapter 3: Printing
PLEASE NOTE: Some of the printing capabilities described in this chapter may be 
optional, that is, depending on how you purchased the software, you may or may 
not need to purchase a separate license for various component described here. 
Description of these capabilities in this chapter is only intended to describe their 
functioning when and if fully licensed.

After configuring PalmPrint appropriately, you can turn your attention to the bottom of the screen, 
where you will see a series of buttons to allow you different printing choices:

If you are using SCS Print Server instead of PalmPrint, the buttons shown above (and 
described below) will be replaced by two buttons: Test IR and Test Print. Tap on Test IR to test 
IR communications with your printer, and tap on Test Print to produce a simple printed message to 
verify that you have printing set up correctly. After that you won't need to interact with SCS Print 
Server directly again, you'll just print from your other application(s) which will send their 
information to SCS Print Server to print.

Printing Memos

Tapping on Memo from the main PalmPrint screen will bring you to a new screen on which will 
appear a list of all your memos (showing you the first line or so of the memo).

There are three options for printing memos; the current option is shown on the large button in the 



center of the bottom of the screen. If you display all your memos (as selected by the "category 
selector" in the upper right hand as shown in the example above), the button reads Print All 
Memos and if you tap it, ALL your memos will be printed, one after the other (you'll actually be 
required to confirm your request in case you do this by accident). If you use the category selector to 
select just one category of memos, you'll see this instead:

Now the button on the bottom reads Print Category, and if you tap the button, all the memos in 
just that one category will be printed, one after the other.

To print just a single memo, tap the stylus on the memo you want to print (it doesn't matter whether 
you are displaying "All" categories or just one category), using the scroll arrows in the lower right of 
the screen if all your memos don't appear. The memo you select will be inverted (white text on a 
black background), like this:

The button now reads Print This Memo, and if you tap it, that's what will happen. If you tap the 
wrong memo, don't worry, just tap on another one (or tap the same one again to "unhighlight" it. Of 
course, after you print one memo, you can select another memo to print. When you're done, tap the 
Done button to return to the main screen.

There are a few special features of the memo screen. First, you'll see a Show button, which 
displays the first 1024 characters of the memo, so if you can't tell which memo you want to print 
from just the first line (which is all that is displayed), tap the Show button (note that the memo is not 
editable in this mode; to modify your memo, you must use the Palm Memo Pad application). Second, 
the memo display, unlike the display in the normal Palm Memo Pad application, skips over leading 
blank lines and blank spaces. This allows you to use PalmPrint to do such things as have a memo 
configured to print on letterhead paper, spaced down several lines to skip over the preprinted 



address, but still allows you to identify the memo in the display (instead of just seeing a blank line).

Advanced Printing of Memos - Control Codes and more

PalmPrint is written to be printer independent, so that if you have something that you print on one 
type of printer, you can switch to another type of printer and still get the same output. As a result of 
this, however, PalmPrint doesn't take advantage of some of the special features built into particular 
printers, which are usually accessed using special non-printing "control codes" (sometimes called 
"Escape sequences"). If you are willing to sacrifice printer independence, PalmPrint lets you 
embed these special codes directly into your memos, letting you change font size, switch to bold or 
italics, print a barcode, or a myriad of other things.

The heart of this special notation are pairs of double angle brackets - "double-less than" symbols and 
"double-greater than" symbols, surrounding one to three digits which are the numeric value of the 
control code - <<27>>,<<18>>, etc. These special symbols ARE found on the built-in keyboard of 
the Palm, but they have no Graffiti equivalent, so to create a memo containing these symbols, you'll 
need to use the built-in (pop-up) keyboard (or download them from the desktop). Once you do this 
once, doing it the second time can be done most simply by copying from the first memo and pasting 
into a new one. Note carefully: in this manual, we represent these symbols by two separate 
one-character symbols (e.g., "less than, less than") because many web browsers don't display these 
special characters properly. But the proper character to use are SINGLE characters (characters 
171and 187 respectively for those with an interest in the details), which are found in the lower right 
corner of the "Int'l" portion of the popup keyboard on the Palm.

As a simple example, "ESC"-W-1 turns on a special "double-wide" mode on a Canon printer, and 
"ESC"-W-0 turns it off. So the following memo would print with a special "headline" at the top (27 
is the numeric value of the ESC character):

<<27>>W1 This is the headline
<<27>>W0And the normal text is starting here

If you want to make a note to yourself of what you are doing with the control codes, you can take 
advantage of this special feature - if the material enclosed between the double angle brackets is 
non-numeric, it is taken as a comment and simply ignored. Since the first line of a memo is what 
shows on the list of memos, you can use this feature to make a note of the relevance of the memo 
which follows. The following example would produce the same output as the example above:

<<Memo with headline>><<27>>W1 This is the headline
<<27>>W0And the normal text is starting here

Printing ToDo List Information

Tapping on ToDo List from the main PalmPrint screen pops up a small window which looks like 
this:

First select the category of items to be printed, or select All to print all ToDo items. If you want to 



print items which have been marked as completed, check the box, otherwise those items will be 
omitted from the output. Also check whether you want any notes attached to your ToDo items to be 
printed (or not). Tap on OK to actually print the ToDo list, or Cancel if you change your mind. The 
printout includes the ToDo item itself, any Note which is attached to the ToDo item (optional), the 
Category of the ToDo item, the Priority, and the Due Date (if one is present).

Printing Address Book Information

Tapping on Address from the main PalmPrint screen will display this screen (assuming that you 
installed the companion program PalmPrint_Address; if you did not, you will be told that you need 
to do so to print information from the Address Book):

This screen in similar, but not identical to, the standard Address Book screen. On the top line is the 
Category selector, as in the Address Book. But on the top of the two columns of information, there 
are two pop-up lists, which display a variety of choices:

These choices are there for two reasons. First, by letting you select the type of information 
displayed, you can choose the information which lets you recognize the name and address you are 
looking for most easily. And second, the heading in the first column is used in conjunction with the 
Find feature on the bottom of the screen to limit the choices. So if, from the sample screen shown 
above, you set the first column selector to Name and then tap the letter "H" below the list of names 
(or use Graffiti to enter "H"), the screen will now look like this:



Of course you can continue; tapping "O" at this point would display only names starting with "HO", 
and so on. But if the first column were set to Company, then tapping H will display those names 
where the company starts with the letter H, rather than the name. Note that the Address Book itself 
can only be sorted in two ways (by name or by company). If the column 1 heading does not match 
the Address Book sorting, then the names shown in this list will not be in alphabetical order, but you 
can still use the Find feature to find names starting with the letter of interest.

Once you locate the name you are looking for, tap on it once to highlight it (it will turn into a "reverse 
video", white letters on black background, to indicate that). Now you have three choices - tap on it a 
second time to popup a window showing you the full details of that name, tap on All Info to print 
out all the known information about that name, or tap on Addr to print out the name and address 
(suitable for labels or envelopes).

There is one more setting, contained in the Envelope/Label menu you'll see when you tap the 
Palm Menu button. This menu will display a screen allowing you to configures envelopes or mailing 
label printouts:

The left and top margins are straightforward. There are also left and top margin settings in the main 
part of PalmPrint (described above), but often when printing envelopes or labels you'll want 
different settings (you might need to print closer to the edge of the envelope, for example) so this 
screen lets you enter settings independent of the standard settings. In addition, if you are printing 
envelopes, the address will often be further offset by a certain amount both horizontally and 
vertically; the Address offset settings let you configure that position. Orientation is 
self-explanatory, but as explained above, this only applies on certain printers (PostScript and PCL 
printers). Font is also self-explanatory; again, this setting lets you choose a standard font for 
envelopes or labels which differs from the standard choice in the rest of PalmPrint (note that when 



you print All Info, Courier font is always chosen so that things will line up nicely). And finally, for 
printing your envelopes, you can specify a return address to be printed.

This application lets you print just a single name/address at one time. If you have more complex 
needs, such as the need to print entire sheets of mailing labels, print phone lists, manage mailing 
lists, or even perform mail merge operations, we have another application, SnailMailer, which 
includes those features (SnailMailer is sold separately).

Printing Datebook Information

Tapping on Schedule from the main PalmPrint screen displays this screen which lets you print 
parts of your schedule taken from the Palm DateBook application:

In the upper right is the schedule selector, which offers you these choices:

Choose the period of time for which you want to print your schedule; note that whatever you pick, 
the software will only print events starting with today, never past events (you can always do that 
from your Palm desktop software). Tap on Print Schedule to print the entire schedule for the 
selected period, or tap on an event to highlight it and then tap on Print Event to print just that event 
(tapping on a highlighted event a second time will display the full details of that event on screen).

The two check boxes on the bottom of the screen, Alarms Only and Hide Untimed, let you limit 
the events which are displayed (and printed).

Printing A Test Page

The very last button on the main PalmPrint screen is labelled Other, which will show you a list of 
other possibilities for printing. The only fixed choice on this list is Test Page. If you select Test 
Page from the list and then tap Other, a test page showing you the different fonts and font sizes 



available will print out.

Printing Emails

Other applications may appear in the popup list next to the Other button, depending on which of the 
optional "plug-in" modules for PalmPrint are installed in your Palm. As of this writing, there are 
four other released plug-ins: PalmPrint_Mail.prc, PalmPrint_Eudora.prc, and 
PalmPrint_iMessenger.prc, for printing from the Palm Mail, Eudora, and Palm VII iMessenger 
applications, respectively, and PalmPrint_Expense.prc, for printing from the Palm Expense 
application. If either of these are installed in your Palm, you will see an item or items in the popup 
list reading Email (Mail), Email (Eudora), Email (iMessenger), and/or Expenses. Note 
that several other email applications, including OneTouch Mail, MultiMail Pro, and others, have 
built-in support for printing via PalmPrint, so for those applications, you simply go to that 
application, and use the Print button or menu found in that application in order to print (read the 
manual of those products for more information about this).

Selecting Email (Mail), Email (Eudora), or Email (iMessenger) and then tapping Other 
brings you to this screen:

A list of your emails is displayed; you can select the category (InBox, OutBox, etc.) on the top line to 
display just the ones of interest. There are two columns; at the top of each column is a popup list that 
lets you select what is displayed in that column:

(Note that "Date" does not appear in the iMessenger screen). The first column heading is more 
important, because you can use it in conjunction with the "Find" feature on the bottom of the screen 
(and the series of letters below the email list) to limit the emails to those in which the selected 
information (except for the date, of course) starts with the letter or letters in the Find field.Thus 
tapping "M" will display only emails from someone whose name starts with "M" if the first column 
is a From field; if the first column is a Subject field, it will display only those emails whose subject 
starts with "M".

Once you have selected an email by tapping on it, you can tap again to display its full information on 
screen, or tap Print Selected to print it. Tap Done to return to the main PalmPrint screen.



Printing Expense Reports

Selecting Expenses from the popup list and then tapping Other brings you to this screen, showing 
a listing your expenses:

On the top line, you can select a category for a particular business trip, which is how the Expense 
application groups expenses. On the bottom of the screen, you can check All to show all expenses in 
that category, or check the From box and set starting and ending dates for the expenses that you 
want to display (and print) and then tap Print to print out the expense report. You can also tap on 
any item to highlight it, and then tap again to display a screen showing the details of that expense (all 
the details which you recorded will appear on the printout).

Printing "Doc" Files

The "Doc" file format is a popular format on the Palm; thousands of documents are available to read 
on your Palm in this format, and several programs are available on the desktop to convert Microsoft 
Word and other files into this format for downloading and viewing on your Palm. To view and print 
files in this format, select Doc Files from the popup list and then tap Other. You will then see a 
screen showing you all Doc files which have been found in your Palm:

You see displayed the name of each document, and the approximate length of the file in printed 
pages. The length is approximate, because without actually printing the document, it's impossible to 
know how many short or even blank lines are contained in the document. A file containing 50 
characters, for example, could all print on a single line, or it could contain 50 "return" characters and 



thus take 50 lines to print.

To select a document, just tap on it, which will highlight the name. At this point you can tap Print 
Document to print the entire document, or either tap the View button or simply double-tap the 
name of the document to view it on a different screen:

Doc files are divided into sections, and the PalmPrint_Doc program displays one section (more or 
less) at a time. You can scroll within a section with the scroll bar on the right edge of the screen, or 
move from section to section with the left and right arrows in the lower right-hand corner of the 
screen. Tapping on Print Selection will print the entire section. Alternatively, you can first drag 
across a section of text (if you drag off the bottom or top of the screen, the screen will scroll 
continuously until you stop) to select it (the selected text will be highlighted). Now tapping Print 
Selection will print only the selected text, which allows you to print chunks of the document in 
question without worrying about exceeding the Palm's clipboard limit (1000 using the standard 
PalmOS).

If you are looking for a specific piece of text, tap Find and you'll get a chance to enter some text to 
find:

Enter the text, which is case-sensitive, and tap Find (or Cancel). If you want to find the same text 
again, just tap Find on the main Details screen, then Find again on the Enter Text screen, and 
you'll see the next occurance of the string, or get a warning beep if the string is not found. Searches 
will occur across the entire document, not just within sections.Searches are always done in the 
forward direction.

Doc files can have "bookmarks," which are often written into the text as "(bm)" or similar strings. 
Some Doc viewer programs display these bookmark symbols on-screen, which seems silly since 
they are not really part of the text itself. PalmPrint_Doc does not display (or print) these bookmarks 
symbols.

Although it is not intended to be a "full-featured" Doc file viewer (like QuickWord or Documents to 
Go), you may find that it is perfectly suitable for your needs, and that you don't need a separate Doc 
viewer program on your Palm. If so, there's one more feature you need, which is the ability to delete 
Doc files which have been downloaded into your Palm. On the main screen of PalmPrint_Doc, 
you'll find a single menu item: Delete. If you highlight a file by tapping on it, selecting the Delete 
menu will delete that file from your Palm (there is no "are you sure?" warning, since even if you 
select this by mistake, which seems highly unlikely, you can always download the file again from 



your desktop).

Printing Information from the Clipboard

For applications which don't support PalmPrint, you may still be able to use the "Clipboard" to 
select text to be printed with PalmPrint. Information is put on the Clipboard by other applications, 
using either the Copy or Cut functions in the Edit Menu of that application. You'll find these 
menu choices in all the built-in Palm applications, as well as a wide variety of other applications 
available for the Palm.Tapping on Clipboard from the main PalmPrint screen prints the current 
contents of the Clipboard.

Monitoring and Cancelling Printing

When you print, the lower portion of the screen will display a small "status window" which lets you 
know what's happening. This is particularly valuable for IrDA printing, since you'll want to know if 
the transmission is occuring, and when it's done, so watch the screen and see what it says (you need 
to keep pointing the Palm at the printer while it is transmitting data!). There is a Cancel button in 
this window; if something goes wrong, or for some reason you want to abort the printout, just tap on 
Cancel (under some conditions you may have to hold the stylus down on the Cancel button for a 
few seconds; it does not always respond instantaneously like most buttons on the Palm).

Printing from Other Applications

PalmPrint was written to allow other applications running on your Palm to use it to do the printing 
for them. For example, our Take An Order! software is one such application, which lets you do 
business in the field, taking orders (or preparing quotations) and printing receipts (or estimates) on 
the spot. SnailMailer is another, which does mailing list management, mail merge, and more. To 
print or transmit data from such applications, you will usually find a menu item or a button in that 
application which will send the information (transparently to you) to PalmPrint for printing or 
transmission. You won't interact with PalmPrint directly in this case. However, before using the 
other application to print for the first time, you must use PalmPrint itself and configure it properly 
(as discussed in Chapter 2). When you leave PalmPrint, your configuration settings are saved, so 
that when the other applications sends data to PalmPrint, it will print correctly.

You'll find a current list of applications which support printing via PalmPrint at 
http://www.stevenscreek.com/palm/palmprint.shtml.

If another application doesn't support PalmPrint, then you may be able to use the Print 
Clipboard function described above to print information from that application. You might also want 
to write to the application's developer, and encourage them to support PalmPrint.

Chapter 4: Hardware Considerations

Serial and Parallel Connectivity



If you don't have infrared capability, one of the most difficult aspects of using PalmPrint for most 
people is getting the hardware configured properly. Most Palms have a serial connector, and most 
printers have parallel input (serial connections send one bit of information at a time, while parallel 
connections send eight bits of information at once using a larger number of wires). If your PalmOS 
handheld unit does NOT have a serial output, you will only be able to print via infrared. If your 
handheld unit has a combination serial/USB connector (e.g., Handspring Visor), you MAY be able 
to print via cable, as described below.

If you have a printer which accepts serial input, the connector on the printer will often be a 
"DB-25 female" connector. This is a long connector, slightly wider on one side than the other, with 
13 holes on the wider side and 12 on the other side. To plug into this connector you need a DB-25 
male cable. The standard output from the Palm, whether the Palm is in the cradle or you are using the 
"HotSync cable" available from 3Com, is a DB-9 female (9 holes, 5 on the slightly wider side, 4 on 
the other) connector. For this situation, you will need a DB-9 male to DB-25 male cable, an item you 
can find in most computer or electronics stores or catalogs and at one time included standard with 
Palm devices.

With most printers, the "polarity" of the connection may be wrong. If you see no response from your 
printer whatsoever, it is likely that you need a "null modem" device (which swaps two of the lines on 
the input) or else a null modem cable. You can find inexpensive 9-pin or 25-pin null modems at most 
computer and electronics stores; Mark/Space (www.markspace.com) sells null modem serial cables 
(also simply called modem cables) to connect to a variety of Palm handheld units (including the Palm 
III, Palm V, and Handspring Visor).

Note that if you have a Handspring Visor and a serial cradle, you can connect the cradle cable 
(usually via a null modem) to the input of a serial printer and printer. If you have a USB cradle, you 
cannot do this.

If you have a printer which accepts parallel input, the connector on the printer will almost 
always be a "Centronics" connector. Note that you cannot simply connect a cable such as a DB-9 
male to Centronics between your Palm and your printer. Cables like that are made to take the parallel 
output of a PC (usually available on a DB-25 connector but sometimes on DB-9) to the parallel input 
of your printer. You must instead have a "serial to parallel converter", which is a more complex (and 
more expensive) device which converts the serial output of the Palm to a parallel signal which can be 
accepted by your printer. Stevens Creek Software sells two such cables, one which attaches directly 
to a Palm III or Palm VII, and a second which attaches to a 9-pin female serial connector which is the 
type found on the end of a serial HotSync cradle or HotSync cable. Visit the PalmPrint web page for 
details.

If your printer manual describes the connector as a "bi-directional" parallel cable, chances are very 
good you will NOT be able to use a serial-to-parallel converter cable, which seem in almost all cases 
to be incompatible with the bidirectional parallel printers.

Note that if you have a Handspring Visor and a serial cradle, you CANNOT connect the cradle cable 
to the serial to parallel converter cable (and then to the printer). If you want to print to a parallel 
printer, you must have not only the serial to parallel converter cable mentioned above, but also a 
special Handspring serial cable (the DCH-H9) sold by Mark/Space (www.markspace.com).

There are also several "infrared to parallel" adapters on the market which essentially add an infrared 
(IrDA) port to your printer by attaching to the existing parallel port. Visit the PalmPrint web page for 
details.

If you have a printer which accepts USB input, this is of no use, even if you have a Palm 
handheld that is also a USB device. USB is a "master-slave" connector, and both printers and Palm 
handhelds are configured as "slaves." You cannot connect two slaves together via USB, so you will 



not be able to print to a USB printer.

Notes on Specific Printers
(Mandatory & Suggested Settings)

Canon BJC-50 and BJC-80

Printer Type: Canon
Baud Rate: Infrared (Serial-to-Parallel printing is also possible to the BJC-80 only if you 
have an older Palm lacking infrared)
Notes: Both of these printers should work flawlessly with any Palm, Symbol, or Visor 
unit. There is one "catch." These printers have two "modes"; one called "BJ" and the other 
called "LQ". The printer MUST be in the "LQ" mode for it to work with PalmPrint. If 
PalmPrint does not appear to be working, check the manual that came with your printer 
for instructions on switching the printer to "LQ" mode.

Citizen PD-04

Printer Type: Epson
Baud Rate: Infrared
Left/top margins: 0
Chars/line: 46
Lines/page: 0

Citizen PN-60i

Printer Type: Epson
Baud Rate: Infrared
Left/top margins: 7/5
Chars/line: 78
Lines/page: 52

Datamax E-3202

Printer Type: ESCPOS
Baud Rate: 57600 (Serial - requires a "null modem" cable available from Datamax)
Use CTS Transmit Flow Control: checked
Left/top margins: 4/4 - Left margin setting is also used on the right; top margin is also used 
on the bottom.
Chars/line: 52 and 68 are the acceptable values A setting of 52 prints in 24 dots per character 
mode; 68 prints in 16 dots per character.
Lines/page: 0
Notes: Printer must be configured in ESCPOS mode, not Epson mode. Baud rate can be 
changed on printer, and must be set in PalmPrint to match, but there is no reason not to use 
the highest setting on both (57600).

Hewlett-Packard LaserJets

Printer Type: PCL (or PostScript if your printer accepts it, although PCL will be faster 
because fewer characters need to be transmitted).
Baud Rate: Infrared for units with built-in infrared including the 5P, 6P, and 2100; 
Serial-to-Parallel printing is also possible for almost all LaserJets and some even have serial 
ports as well.



Chars/line (the following applies if you are using the HP (Palm fonts) mode of printing; 
otherwise the setting is up to you): When Courier font is selected, automatically adjusted to 
92 for 9-pt, 84 for 10 pt, and 74 for 12 pt. Can be changed subsequently if desired. For 
Times and Helvetica fonts, this setting is ignored; the width of the page is internally fixed so 
that the full page (except for left/right margins) will be used based on the width of individual 
characters on that line.
Lines/page (the following applies if you are using the HP (Palm fonts) mode of printing; 
otherwise the setting is up to you): Automatically adjusted when you change point size to 62 
for 9-pt, 52 for 10 pt, and 47 for 12 pt. Can be changed subsequently if desired.
Notes: Newer units (6P, 2100) work flawlessly with PalmPrint. The 5P's appear to be 
problematic; some work, some don't; you need to test any particular printer to see if it does 
work (there are some timing issues between the IR on the 5P and the Palm which cause this 
problem).

Hewlett-Packard DeskJet 340/350

Printer Type: PCL
Baud Rate: Infrared with the IR attachment available for this printer; otherwise 
Serial-to-Parallel printing is also possible.
Chars/line (the following applies if you are using the HP (Palm fonts) mode of printing; 
otherwise the setting is up to you): When Courier font is selected, automatically adjusted to 
92 for 9-pt, 84 for 10 pt, and 74 for 12 pt. Can be changed subsequently if desired. For 
Times and Helvetica fonts, this setting is ignored; the width of the page is internally fixed so 
that the full page (except for left/right margins) will be used based on the width of individual 
characters on that line.
Lines/page (the following applies if you are using the HP (Palm fonts) mode of printing; 
otherwise the setting is up to you): Automatically adjusted when you change point size to 62 
for 9-pt, 52 for 10 pt, and 47 for 12 pt. Can be changed subsequently if desired.
Notes: No known problems or special tricks.

Monarch 6015

Printer Type: Monarch
Baud Rate: 19200 (Serial)
Use CTS Transmit Flow Control: MUST be checked
Left/top margins: 0 (or larger if desired) - Left margin setting is also used on the right; top 
margin is also used on the bottom.
Chars/line: 48, 42, 38, 32, and 24 are the acceptable values; as you decrease the number, 
the printer will printer larger and larger characters.
Lines/page: 0
Orientation: With 24 characters/line only, Landscape (L) orientation can be used to print 
"sideways" characters
Font: setting is ignored (font size is chosen on the basis of characters per line)
Notes: Print quality seems to depend on batteries. In our experience you can only get good 
quality with high-energy (nickel-metal hydride) batteries.

O'Neil 2t

Printer Type: Text w/Breaks
Baud Rate: Infrared (or 9600 if using cabled serial connection)
Left/top margins: 0/3 - Left margin setting is also used on the right; top margin is also used 
on the bottom.
Chars/line: 38



Lines/page: 0

O'Neil 8i

Printer Type: Text w/Breaks
Baud Rate: Infrared (or 9600 if using cabled serial connection)
Left/top margins: 0/0 - Left margin setting is also used on the right; top margin is also used 
on the bottom.
Chars/line: 80
Lines/page: 56

Pentax PocketJet 200

Printer Type: PocketJet 200
Baud Rate: Infrared (Fast) [Very important; will not work in "Infrared" setting], or 57,600 
if connecting via cable
Use CTS Transmit Flow Control: MUST be checked if using serial (cabled) printing
Left/top margins: as desired. Left margin setting is also used on the right; top margin is also 
used on the bottom.
Chars/line: When Courier font is selected, automatically adjusted to 124 for 9-pt, 114 for 10 
pt, and 100 for 12 pt. Can be changed subsequently if desired. For Times and Helvetica 
fonts, this setting is ignored; the width of the page is internally fixed so that the full page 
(except for left/right margins) will be used based on the width of individual characters on 
that line.
Lines/page: Automatically adjusted when you change point size to 78 for 9-pt, 66 for 10 pt, 
and 57 for 12 pt. Can be changed subsequently if desired.If using roll feed paper, set 
lines/page to 0 and make sure that the top margin is set to a value other than 0.
Orientation: Portrait only is supported
Manual Feed: If checked, the software will pause before each page and wait for you to tap 
"OK" on the screen before proceeding. Should be UNchecked if you are using roll feed 
paper.

Seiko DPU-3445

Printer Type: Seiko
Baud Rate: Infrared (Fast) [Very important; will not work in "Infrared" setting]
Left/top margins: 0 (or larger if desired) - Left margin setting is also used on the right; top 
margin is also used on the bottom.
Chars/line: 52 and 79 are the acceptable values A setting of 52 prints in 24 dots per character 
mode; 79 prints in 16 dots per character.
Lines/page: 0

SiPix Pocket Printer A6

Printer Type: SiPix Pocket Print
Baud Rate: Infrared, or 115,200 if connecting via cable
Use CTS Transmit Flow Control: MUST be checked if using serial (cabled) printing
Left/top margins: as desired. Left margin setting is also used on the right; top margin is also 
used on the bottom.
Chars/line: When Courier font is selected, automatically adjusted to 56 for 9-pt, 52 for 10 
pt, and 42 for 12 pt. Can be changed subsequently if desired. For Times and Helvetica 
fonts, this setting is ignored; the width of the page is internally fixed so that the full page 
(except for left/right margins) will be used based on the width of individual characters on 
that line.



Lines/page: Automatically set to 31. If using roll feed paper, set lines/page to 0 and make 
sure that the top margin is set to a value other than 0.
Orientation: Portrait only is supported
Manual Feed: If checked, the software will pause before each page and wait for you to tap 
"OK" on the screen before proceeding. Should be UNchecked if you are using roll feed 
paper.

Using PalmPrint to Transmit Data to A Computer

To transmit data to a computer, the connector which you use to perform a HotSync is the 
proper connector. The only "trick" here is that you must first turn off HotSync on your desktop 
computer, because you are going to establish a connection between your Palm and your computer 
which bypasses the standard HotSync software. Of course, you won't need this trick if you are 
transmitting information to a computer which is not running HotSync at all. Once you turn off 
HotSync (if necessary), start your terminal emulation software (whether standalone, or the 
Communications module of a "works" program such as ClarisWorks), configure the connection 
settings (primarily the baud rate) within your desktop software, and make sure to select the button or 
menu item which opens the connection between the terminal emulation software and the serial port of 
your computer (it is usually not opened automatically). Some step-by-step examples follow for 
software commonly available:

Using HyperTerminal (Windows 98)

If you have Windows 98, here are complete instructions for transferring information from your Palm 
to your desktop computer, using the HyperTerminal application which is included with Windows 98:

1. Stop your HotSync program (if it is running), but leave the cabling from your Palm to 
your computer exactly as it was.

2. Select Start Menu -> Programs -> Accessories -> Communications -> 
HyperTerminal

3. Double-click on Hypertrm.exe
4. In the Connection Description screen, enter as the Name: Palm Direct (or anything 

else you like), and select any icon.
5. In the Connect To screen, set the menu to Connect Using: Direct to Com1 (or 

whatever Com port you are using to connect your Palm). Ignore the area code and phone 
number fields.

6. In the Port Settings screen, set the Bits per second (known as the Baud rate in 
PalmPrint) to any number; try 57,600 first. Set the Data bits to 8, the Parity to None, 
the Stop bits to 1, and Flow Control to Hardware. Click OK.

7. In the Call Menu, select Call. Actually this will be done automatically after step 6 when 
you are first setting up the configuration; you'll only need to do this yourself on subsequent 
connections.

8. Start PalmPrint on your Palm, set the Printer Type to Plain Text/None or Text 
w/Breaks, and the Baud Rate to the same number to selected at step 7. Now whatever 
you "print" from PalmPrint (or any other application which uses PalmPrint to do its 
printing) will appear in the HyperTerminal screen. If you select Capture Text from the 
Transfer menu, you can capture the information to a file. To send the information 
directly to a printer, check Capture to Printer in the Transfer menu. Print what you 
want from your Palm, then UNcheck Capture to Printer, and the material you have 
printed will be passed on to the printer connected to your computer.

9. When you exit HyperTerminal, answer Yes when asked if you want to save this 
session. An icon (which you selected at step 4 above) will appear in the HyperTerminal 
folder. In future sessions, you can just double-click on this icon, and proceed right to step 



7.

Using HyperTerminal (Windows 95)

If you have Windows 95, here are complete instructions for transferring information from your Palm 
to your desktop computer, using the HyperTerminal application which is included with Windows 95:

1. Stop your HotSync program (if it is running), but leave the cabling from your Palm to 
your computer exactly as it was.

2. Select Start Menu -> Programs -> Accessories -> HyperTerminal
3. Double-click on Hypertrm.exe
4. The Location Information window which appears is irrelevant. You must fill in your 

area code (it won't proceed if you don't), then click OK.
5. In the Connection Description screen, enter as the Name: Palm (or anything else you 

like)
6. In the Phone Number screen, set the menu to Connect Using: Direct to Com1 (or 

whatever Com port you are using to connect your Palm).
7. In the Port Settings screen, set the Bits per second (known as the Baud rate in 

PalmPrint) to any number; try 57,600 first. Set the Data bits to 8, the Parity to None, 
the Stop bits to 1, and Flow Control to Hardware. Click OK.

8. In the Call Menu, select Connect.
9. Start PalmPrint on your Palm, set the Printer Type to Plain Text/None or Text 

w/Breaks, and the Baud Rate to the same number to selected at step 7. Now whatever 
you "print" from PalmPrint (or any other application which uses PalmPrint to do its 
printing) will appear in the HyperTerminal screen. If you select Capture Text from the 
Transfer menu, you can capture the information to a file. To send the information 
directly to a printer, check Capture to Printer in the Transfer menu. Print what you 
want from your Palm, then UNcheck Capture to Printer, and the material you have 
printed will be passed on to the printer connected to your computer.

10. When you exit HyperTerminal, answer Yes when asked if you want to save this 
session. An icon (which you selected at step 4 above) will appear in the HyperTerminal 
folder. In future sessions, you can just double-click on this icon, and proceed right to step 
8.

Using Terminal (Windows 3.1)

If you have Windows 3.1, here are complete instructions for transferring information from your 
Palm to your desktop computer, using the Terminal application which is included with Windows 3.1:

1. Stop your HotSync program (if it is running), but leave the cabling from your Palm to 
your computer exactly as it was.

2. Start the Terminal application.
3. Select Communications from the Settings menu.
4. Set the Baud Rate; try 19,200 first. Set the Data bits to 8, the Parity to None, the Stop 

bits to 1, Flow Control to Hardware, and Connector to COM1 (or whatever port your 
Palm is connected to). Click OK.

5. Start PalmPrint on your Palm, set the Printer Type to Plain Text/None or Text 
w/Breaks, and the Baud Rate to the same number to selected at step 4. Now whatever 
you "print" from PalmPrint (or any other application which uses PalmPrint to do its 
printing) will appear in the Terminal screen. You can use Copy in the Edit menu to copy 
the text to your Clipboard, and then transfer it to another application. Our attempts to use 
Receive Text File in the Transfers menu resulted in GPF crashes of the Terminal 
application, so we can't recommend that!



Using AppleWorks/ClarisWorks (Macintosh)

The Mac doesn't come with any standard terminal emulation software, but AppleWorks (formerly 
ClarisWorks) is probably the most popular program which includes a Communications module. Here 
are complete instructions for transferring information from your Palm to your Mac using 
AppleWorks:

1. Stop your HotSync program (if it is running), but leave the cabling from your Palm to 
your computer exactly as it was.

2. Start AppleWorks, and open a new Communications document.
3. Select Connection under the Settings menu. Set the Method to Serial Tool. Set the 

Current Port to the one to which your HotSync cable is attached. Configure the Baud 
Rate to whatever you like; try 57,600 first. Set Data Bits to 8, Parity to None, Stop 
Bits to 1, and Handshake to DTR & CTS. Click OK.

4. Select Open Connection in the Session menu.
5. Start PalmPrint on your Palm, set the Printer Type to Plain Text/None or Text 

w/Breaks, and the Baud Rate to the same number to selected at step 3. Now whatever 
you "print" from PalmPrint (or any other application which uses PalmPrint to do its 
printing) will appear in the Terminal screen. You can use Copy in the Edit menu to select 
information and then transfer it to other applications. Alternatively, use Capture to File in 
the Session menu to capture the text to a file; select Stop Capture when you're done.

6. If you want to print the information from your desktop to your printer, first select Clear 
Screen from the Session menu, then select Clear Saved Lines. Now "print" from 
PalmPrint to the screen of your computer. When done, select Print from the File menu 
in AppleWorks and you'll send the material on to your printer.

7. When you're done, select Close Connection in the Session menu.
8. Use Save in the File menu to save the session as a document. In the future you can just 

open that document and skip right to step 4.

Using Terminal (WindowsCE)

PalmPrint can also be used to transfer data from the Palm to a WindowsCE handheld computer. 
Unlike when you connect to a desktop computer, where the same cabling you use for HotSync'ing is 
appropriate, when you connect to a WindowsCE computer you'll need a null modem device of some 
type. We have connected the two with the following setup: a DB-9 male to DB-25 male cable, a 
DB-25 null modem, and the DB-25 female to DB-9 male adapter which comes with the Palm. No 
doubt simpler connections are possible. Once the connection is made:

1. Select Start Menu -> Programs.
2. Double-click on Communications.
3. Double-click on the Terminal application.
4. Click on Make a New Connection. Set the Session Name to something appropriate 

(like Palm), set Select a Modem to Hayes Compatible (this isn't true but it will be 
ignored). Enter an Area Code and Telephone Number because you are required to; 
they too will be ignored.

5. Click on Configure and make sure to check Manual Dial; this is the only real trick. 
Configure the Baud Rate to whatever you like (you just need to set the same Baud Rate 
within PalmPrint), Data Bits to 8, Parity to None, Stop Bits to 1, and Flow Control 
to Hardware. Click OK twice.

6. Double-click on the new icon (labelled Palm in our example). A "dialing" window will 
appear briefly and then disappear; you are now connected.

7. Start PalmPrint on your Palm, set the Printer Type to Plain Text/None or Text 
w/Breaks, and the Baud Rate to the same number to selected at step 5. Now whatever 
you "print" from PalmPrint (or any other application which uses PalmPrint to do its 
printing) will appear in the Terminal screen. You can use Copy in the Edit menu to copy 



the text to your Clipboard, and then transfer it to another application.
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